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Introduction

This manual describes all the methods available for installing desktop card printers.

Desktop Card Printers

Desktop card printers apply personalization to plastic cards. Personalization includes printing,
encoding magnetic stripe data, and reading or programming smart cards. Some printers also
have one or two laminators, which apply a protective layer to cards.

A desktop card printer is a self-contained unit that receives data from a PC (or other computer),
personalizes the card using the data, and ejects the card. Desktop card printers have one or two

cards in them at a time, and are designed to issue cards where the user is, called on-demand
printing or instant issuance.

About this Manual

This manual applies to desktop card printers and describes:
e The Card Printer Driver
¢ Supported Windows operating systems
¢ Preparing the printer for installation
*  Windows installation
This manual is intended for anyone installing the desktop card printer. However, some

procedures require a higher level of technical knowledge or experience. Use the following icons
to guide you when choosing whether to perform a procedure yourself or to ask for assistance.




Introduction

Operator: The green icon represents the Operator, who uses the printer to create
cards and works at the direction of others in the organization.

Administrator: The tan icon represents the Administrator, who has responsibility for
the system within the organization. The Administrator supervises the Operator in
, Mmost cases.

Service Provider: The blue icon represents the Service Provider, who has training
and experience to solve many problems and to perform advanced setup tasks.

For More Information

The following information is available to help you use the desktop card printer:

* The Quick Install Guide is packaged in the carton with the printer. For the Kiosk Printer, a
Quick Reference Guide is packaged in the carton. For most printers, the Quick Install
Guide also is posted on the website.

¢ This manual, the Desktop Card Printers: Installation Guide (539808-001) is available
from the website. It provides detailed information for all installation choices.

¢ For users of the Windows Card Printer Driver, InfoCentral is installed when the driver is
installed. You can open it using the shortcut in the Start > Programs menu. InfoCentral is
also available on the driver CD without installing the driver.

¢ For users of the OpenCard format, the OpenCard Option CD (558868-001) includes a
Printer Guide (539398-001).

« The printhead is user-replaceable. Replacement printheads include instructions
(539295-001) for replacing the printhead.

¢ A Firmware Update Program is available to use with the Windows Card Printer Driver
and a firmware file. The download for the Firmware Update Program includes
instructions (539745-001).

¢ The Solutions Guide (539707-001) provides detailed information for integrators. The
Solutions Guide is available for download from the service website.

Installation Guide 2
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Before You Install

This section describes:
¢ Installation requirements
¢ Choosing your installation method

* Preparing the printer for installation

Installation Requirements

PC Requirements

Use a PC that meets or exceeds the following:
e A 32-or 64-bit processor, running at 2 GHz or faster
*  Memory (RAM):
— 1 GB or more for Windows XP

— 2 GB or more for Windows 7, Windows 8.1, Windows Server 2008, or Windows
Server 2012

¢ Atleast 15 GB free space on the hard drive
* One of the following operating systems with the latest service pack installed.
— 32-bit:
< Windows 7
< Windows 8.1
< Windows XP
< Windows Server 2003 R2
— 64-bit:
< Windows 7
< Windows 8.1
< Windows Server 2008
< Windows Server 2012 R2
e USB port or Ethernet network connection

If the printer does not have a built-in Ethernet port and you plan to use a direct network
connection, you also need a print server.

« ID software to capture and organize the data to appear on each card.




Before You Install

Requirements for a Direct Network Connection

To install a printer using the Built-in Ethernet option, the following components are required:

* An Ethernet network that uses the TCP/IP protocol and can run at 100 megabits per
second, also called 100base-T. Printers also support 10base-T.

« A printer equipped with the Built-in Ethernet feature OR a print server. The HP
Jetdirect 175, revision C, print server has been tested.

* An Ethernet cable to connect the printer to the network. An Ethernet cable is not
supplied with the printer.

« A PC that meets the requirements listed above, and is connected to, and communicating
with, the network.

¢ You can connect up to 20 directly networked printers to one PC. If you need to install
more than 20 printers on one PC, contact your service provider for assistance.

Site Requirements

¢ Maintain the minimum clearance around the printer as shown in the following

illustrations.
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T““x Laminating Printers
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« Place the printer in an environment with temperatures ranging from 60° F to 95° F (15° C
to 35° C).

« Use a single phase, 3-wire, grounded receptacle.

¢ Keep all dust, dirt, food, and liquids away from the printer.

* Keep paper and foreign materials off the printer.

« Place the printer on a sturdy, level surface.

¢ Place the printer away from direct sunlight.

« Do not place the printer near heat ducts, fans, or other air vents.

« Do not use the printer for purposes other than the intended use.

¢ Prevent debris from entering the printer.

* Place the printer in a clean office environment, protected from any type of construction.

Electrical Requirements

The power supply is rated as follows:

Printer Model Voltage, AC* Cycle, HZ* Amps
Manual Feed 100-120, 220-240 50-60 3.0
Simplex 100-120, 220-240 50-60 3.0
Duplex 100-120, 220-240 50-60 3.0
Laminating 100-120, 220-240 50-60 3.0

#. Self-adjusting
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Select Your Installation Method

Your installation method depends on how many users will print to the card printer, the operating
Q system you use to send card data, and other decisions in your environment.

) Will you print from a PC running a Windows operating system?
If yes, continue with "Windows Installation Choices".

Will you print monochrome cards using ASCII data and the OpenCard
format?

If yes, see "OpenCard Installation".

Windows Installation Choices

Do you have a CD for installation or will you use downloaded files?

The printer ships with a CD in the printer carton. In most cases, install the driver from the
CD. If you do not have access to the CD, you can install the driver from a downloaded
file. See "Obtaining the Downloaded File" for more information about using downloaded
files.

Will you use bidirectional (two-way) communication between the printer
and driver?

The printer and driver are designed to use bidirectional communication. It is required to
enable all the printer and driver features. Continue with these questions if you plan to
use bidirectional communication.

If you do not plan to use bidirectional communication, see "Unidirectional Printing" for
more information about installation options and instructions.

Will you connect the printer to the PC using a USB cable?

A local connection uses a USB cable between a port on the PC and the USB port on the
printer. To install the printer using a local USB connection, see "Installing the Driver
Using a USB Connection".

Will you connect the printer and PC to the network, with a network cable
connecting the printer’s network port to your network?

A direct network connection uses the optional built-in Ethernet port on the printer and a
network port. To use a direct network connection, see "Installing the Driver Using a
Network Connection”.

Will you connect the printer to the network using a print server?

Printers with only a USB connection can be used over a network if the printer USB port
is connected to a print server and the print server is connected to the network. To use a
print server for networked printing, see "Network Installation Using a Print Server".

Will you connect the printer to the PC using a wireless connection?

Printers can connect wirelessly to a PC or to a network, using a wireless print server. To
use a wireless connection for the printer, see "Wireless Network Connection".

Installation Guide 6
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Will you install more than one printer on a PC?

Do you want to send cards from one PC to two or more printers? You can install several
printers on a PC, using a variety of connection methods.

For information about successfully using more than one printer from a PC, see "Installing
More than One Printer on a PC".

Will you install one printer on the network, and print to it from several PCs?

You can connect one printer to several PCs on a network. There are no special concerns
when sending cards from multiple PCs.

Do you want to use a printer pool, where the PC distributes the cards to the
first available printer?

A printer pool collects all the card printers installed on one PC into a group and sends
cards to the next available printer. To set up and use a printer pool, see "Printer Pooling".

Do you want to install the printer on one PC, and use it from another PC on
the network (printer sharing)?

Printer sharing is a Windows feature that permits using resources on a different PC,
when both PCs are installed on the same network. To install and use a shared printer,
see "Shared Printers".

Do you want to use a newer driver in place of the one currently installed?
See "Updates, Upgrades, and More" for information about updates.

Installation Guide
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Preparing the Printer

This section describes:

"Installing Supplies and Powering On the Printer"
"Network Address Settings"

Installing Supplies and Powering On the Printer

This section provides the steps for installing supplies and powering on the printer.

.-'rl.:{‘-. 1
() 2
3
4

Unpack the printer.

Install the continuous cleaning
sleeve.

Load the print ribbon on the
cartridge.

— Place the full spool near the slotted
disk.

— Place the empty spool with the cap
near the black gear.

Install the loaded print ribbon cartridge
in the printer.

Installation Guide
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Install the laminator supply material (if the printer has a laminator).

ag ¢ b%u!, c:ﬂ d

Load cards in the input hopper (if the printer
has a hopper).

Do not connect the printer and PC at this
time.

Power on the PC or host computer. Make sure
it is fully operational before connecting the
printer.

For a printer connected using the built-in
Ethernet port on the printer, connect the
network cable to the printer and to the
network.

Important: For a printer connected using a
USB cable or a print server, do not connect
the USB cable at this time. Continue with
step 9.

Power on the printer.

a Connect the power supply to the
printer.

b Connect the power cable to the
power supply.

¢ Connect the power cable to a facility
power source.

d For printers with laminators,
push the power switch to On.

Installation Guide
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10 When the printer powers on, the status
light displays a series of patterns. The
location of the status light depends on
the printer model:

Ready Button ! | Status Light

Ready Bution Status Light

11 The status light displays the following:

— Amber when the printer is powered on. P

— A series of colors as it initializes.
L Il )

— Steady green when the printer is ready. a

For printers connected using a USB cable between the printer and PC, continue with
"Installation on Windows".

For printers connected over a network, continue with "Network Address Settings".

Network Address Settings

The Address Mode determines how the network address of the printer is assigned. The choices
are DHCP and Static IP. DHCP (Dynamic Host Configuration Protocol) means that the network
assigns the IP address to the printer. Static IP means that you set the IP address assigned by
your network support personnel. Network support personnel can tell you whether the network
uses DHCP or static IP addressing.

Locate the Current Address Mode

1 Make sure the printer is connected to the
network using an Ethernet cable and is
powered on.

Installation Guide 10



Begin when the LCD panel shows

Before You Install

"Printer Ready" on Line 1 of the

display. Printer Ready -
Status

Press the Enter key to enter the

~

menu system. ﬂ u m
Il i

Make sure "Status" appears on

Line 2 and press the Enter key.

Down
Ao

With "Status Menu" displayed on
Line 1, press the Up or Down Arrow key to
display "Network" on Line 2.

Press the Enter key. "Address Mode" displays on
Line 2.

Press the Enter key to view the Address Mode.
The options are DHCP or Static IP.

— If the Address Mode is DHCP and that is
what you plan to use, continue with "Retrieve
DHCP Values".

— If the Address Mode is Static IP and you plan to use DHCP, see "Change the

Address Mode to DHCP".

— If the Address Mode is DHCP and you plan to use Static IP, see "Change the

Address Mode to Static IP".

T

Enter Status
Light

Ready

Arrow

Line 1
Line 2

Status Menu
> Network

AANED o

Network Status
> Address Mode

AAPNED e

— If the address mode is Static IP and that is what you plan use, see "Change Static IP

Values".

Press the Enter key repeatedly to return to the Main Menu. "Exit" displays on Line 2.

Continue with the section you selected in step 7.

Change the Address Mode to DHCP

1

With “Main Menu” displayed on line 1, press the

Up or Down Arrow key to display "Configuration”

Press the Enter key to enter the Configuration
menu.

Main Menu
= Exit

AAFNED Mo

Installation Guide
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3 With "Configuration” displayed on Line 1, press
the Up or Down Arrow key to display "DHCP/ - .
Static IP" on Line 2. Configuration

4 Press the Enter key. The current Address Mode > DHCP/Staﬂ c IP

value displays on Line 2. n ﬂ m [ }o

5 Press the Up or Down Arrow key to display
DHCP.

6 Press the Enter key.
7 Apply/Restart" appears on Line 2. Press the Enter key to restart the printer.
8 Continue with "Retrieve DHCP Values".

Retrieve DHCP Values

Continue with the following steps after confirming the Address Mode or changing the Address
Mode to DHCP.

1 Begin when the LCD panel shows "Printer Ready" on Line 1 of the display.
2 Enter the Status menu.

— With “Main Menu” displayed on line 1, press
the Up or Down Arrow key to display "Status".

Main Menu
= Status

AANED o

— Press the Enter key to enter the Status menu.

— With "Status Menu" displayed on Line 1,
press the Up or Down Arrow key to display
"Network" on Line 2. Status Menu

> Network

AANED o

3 Press the Enter key. "Address Mode" appears on
Line 2.

4 Press the Up or Down Arrow key to display IP NEth:IDdr‘k Sta‘; uds
Address on Line 2. > Address Mode

AAPNED e

5 Press the Enter key to display the IP Address.

IP Address
192.168.1.155

AANED o
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9
10

Write down the IP Address.

Press the Enter key to return to the Network Status
menu. "Subnet Mask" displays on Line 2. Press the
Enter key to display the Subnet Mask.

Press the Enter key to return to the Network Status
menu. "Gateway Addr" displays on Line 2.

Press the Enter key to display the Gateway Address.

Press the Enter key to return to the Network Status

Before You Install

menu. Press the Up or Down Arrow key to display "Exit" on Line 2.

11 Press the Enter key repeatedly to return to the "Printer Ready" display.

Change the Address Mode to Static IP

Continue with the following steps after determining the current Address Mode.

1

With “Main Menu” displayed on line 1, press the

Up or Down Arrow key to display "Configuration”.

Press the Enter key to enter the Configuration
menu.

Main Menu
= Exit

AANED o

With "Configuration" displayed on Line 1, press

the Up or Down Arrow key to display "DHCP/
Static IP" on Line 2.

Press the Enter key. The current Address Mode
value is displayed on Line 2.

Press the Up or Down Arrow key to display

Configuration
> DHCP/Static IP

A PN E] o

Static IP.

Press the Enter key. Continue with "Change Static IP Values".

Change Static IP Values

Continue with the following steps after setting the Address Mode to Static IP or verifying that the
Address Mode is Static IP.

1

If needed, move to the Configuration

menu. :
With “Main Menu disolaved Main Menu —f Line 1
— Wi ain Menu” displayed on . . )
line 1, press the Up or Down Confi guration — Line 2

Arrow key to display

"Configuration”. |:|{:'

— Press the Enter key to enter the
Configuration menu.
Down
Arrow

Up

T

Enter Status
Light

Ready

Arrow

Installation Guide
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10

11

With "Configuration" displayed on Line 1, press
the Up or Down Arrow key to display "IP
Address" on Line 2.

Press the Enter key to select IP Address.

The printer shows the current IP address and a
cursor appears under the first byte of the
address. (The address byte shows three digits
when it can be changed and the cursor appears
under the right-most digit.)

Press the Up or Down Arrow key to change the
numbers of the IP address.

When the first byte is correct, press the Enter key
to move to the second byte.

Repeat for the third and fourth byte of the IP
address. After entering the fourth byte of the
address and pressing the Enter key, "Subnet
Mask" displays on Line 2 of the LCD panel.

Press the Enter key. The current Subnet Mask

value appears with the cursor under the first byte.
Set the subnet mask using the same process as
the IP address. After entering the fourth byte and
pressing the Enter key, "Gateway Addr" displays.

Press the Enter key. The current gateway
address value appears with the cursor under the
first byte. Set the gateway address using the
same process as the IP address.

After entering the fourth byte of the gateway
address and pressing the Enter key, "Apply/
Restart" displays.

Press the Enter key to apply the values and
restart the printer.

[

Before You Install

Configuration
> IP Address

AANED o

IP Address
192.168.1.155

A PN E] o

IP Address
> Subnet mask

AANED o

Gateway addr
192.168.1.1

Ad N E] Mo

IP Addresses
>Apply/Restart

AANED o

Installation Guide

14




s |Nstallation Guide

Installation on Windows

This section provides information about installing the printer and driver on a PC running a
Windows operating system. See "Windows Installation Choices" for installation choices.

This section describes how to install the printer on a PC with a Windows® operating system.

See the releasenotes.rtf file (delivered with the Card Printer Driver) for detailed information
about supported Windows operating systems.

Installing on a Windows Operating System

* Bidirectional communication
— "Obtaining the Downloaded File"
— "Installing the Driver Using a USB Connection"
— "Installing the Driver Using a Network Connection"
— "Network Installation Using a Print Server"
— "Installing More than One Printer on a PC"
— "Wireless Network Connection"
<« "Wireless Network Connection with an Existing Network"
<« "Wireless Network Connection with a Peer (Ad Hoc) Network"
<« "Install and Set Up the Wireless Print Server"
— "Printing Cards Using Bidirectional Communication"
e Unidirectional communication
— "Unidirectional Printing"
— "Installing the Unidirectional Driver"
e "Printer Pooling"
e "Shared Printers"
For troubleshooting, see "Installation Troubleshooting".

For information on updating an installed driver, see "Updates, Upgrades, and More".
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Installation on Windows

Installing the Driver with Bidirectional Communication

You can install the driver either from the CD that ships with the printer or from a downloaded file.

Most of the installation process is the same whether you install from a downloaded file or from a
CD. Use the following instructions to install the driver. Differences are noted where necessary.
You can install the driver using either of the following:

e "Installing the Driver Using a USB Connection"

¢ "Installing the Driver Using a Network Connection”

Obtaining the Downloaded File

The printer ships with a CD in the printer carton. In most cases, you install the driver from the

/Q CD. If you do not have access to the CD, you can install the driver from a downloaded file.
J ‘.I Before installing the printer, do the following:
N 1 Obtain the download file using one of the following methods:

— Go to the Drivers and Downloads page of the website (or the Products page for the
printer) and select the driver for your printer and operating system. If the License
Agreement displays, accept the agreement. Save the file to a location on your PC,
such as C:\Temp.

— Receive the file on a portable storage medium, such as a CD or USB drive, and copy
it to your hard drive.

— Receive the file by email and save it to your hard drive.
Tips for Success
« The downloaded file has a name similar to “XP_Series_xxBIT_xx_x.exe.”

¢ You can use the same downloaded file to install the driver on multiple PCs. The license
agreement you accept during download applies to all installations of the driver.

Installation Guide 16
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Installing the Driver Using a USB Connection
1 Prepare the printer for installation. See "Preparing the Printer" for the steps to follow.
2 Log on to the PC as a user with Administrator access.
3 Do one of the following:
— If you are installing from a downloaded file, locate the file on the PC. Double-click
the downloaded file to start the card printer installation.
OR

— If you are installing from the CD,
insert the CD in the PC’s drive.

If the Autoplay dialog box displays,
click Run CdBrowser.exe.

When the driver installation window
opens, click “Install the Printer.”

4  Click “Yes” on the User Account
Control dialog box if it displays.

5 Acceptthe license agreementand ..
then click “Next.”

e ]
B LM AR TR D ey w L O LS ey E

LNEST W™ o oot s o Sukobd of & Dl g | W |
L e = an b

B I L ——
v g S et e mabrady T vy mm e
W T [ e T e | A T e T -

6 Select "Local Printer Connection" s penee mennvi

and click “Next.”
Ingtal

W Lol Perier Corvmetion
Drpaciiy Meteniosd Prrler
Derwer Pt Pl
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Installation on Windows

7 Verify that you have prepared the TEard Frivier

printer as instructed on the
Connect dialog box.

Connect..

1) Ikl eupilis n B privks

2] Puoveet o1 B e ol v bt g o,
W Convesct e printes io fhe PC

4] The P dessets the prntes Wk bt the st by cpiete:

[ mets || Coce |

8 Connect the USB cable to the
printer. Position the USB cable
at an angle to properly insert it
into the printer.

The PC detects the printer and
completes the installation.

9 When the completion message displays,
click OK.

10 The installation program places an icon for
the printer on the Windows toolbar.
Double-click the icon to open the Printer
Toolbox. (Or, click Start > All Programs >
Datacard Card Printers > Printer Name.)

11 Click “Print Sample Card” to print a sample
card from the driver.

Insert USB cable

~. atanangle
-

e )

St | Fulgs b Faligs | Comies | i |
;g B T & R o]

| T et e i
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Installation is complete when the sample card prints
successfully.

Installation on Windows

| Company Mame
——

Higree Can 'Wa Halg Youl

Installing the Driver Using a Network Connection

1

A W N

Prepare the printer for installation. See "Preparing the Printer" for the steps to follow.

Obtain the IP address of the printer. See "Network Address Settings" for detalils.

Log on to the PC as a user with Administrator access.

Do one of the following:

— If you are installing from a downloaded file, locate the file on the PC. Double-click
the downloaded file to start the card printer installation.

OR

— If you are installing from the CD,
insert the CD in the PC'’s drive.

If the Autoplay dialog box displays,
click Run CdBrowser.exe.

When the driver installation window
opens, click “Install the Printer.”

Click “Yes” on the User Account
Control dialog box if it displays.

Accept the license agreement and
then click “Next.”

DD LN LN S sSPED T 1O D D D0 LT D PN Dy L
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Installation on Windows

7 Select “Directly Networked Printer”

) [Card Prister
and click "Next.” _
Iraasl

Loal Prries Coraciion

Dves

< Bk Nets | [ Carmel |

8 When the completion message
displays, click OK.

9 The Printer Properties dialog box
opens.

- P e

10 Select the Ports tab.

|| Ptz Sac baleamg potish Dooaments wadll g e s st e

11 Select the printer and then click #o rn b
“Configure Port.” ks e :

T OOMD el P
T CTAL el el
FLE Fros s Fily

12 Enter the printer IP address in the + EE e T -
Enter Network Address dialog box. : -

preT.
If you are installing using a print ’:::::ﬂ::""
server, enter the IP address of the
print server.
13 Click “Test.”
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14 Wait for the “Successfully communicated” message and click OK.

If the “Unable to communicate” message displays, troubleshoot a communication
problem. See "Installation Troubleshooting".

15 Close the Enter Network Address and Printer Properties dialog boxes. A message
displays that the printer has been identified.

16 Print a sample card.

a Open the Printer Toolbox

(click Start > Al N —
Programs > Datacard Card PR :
Printers > Printer Name). ol |
b Click “Print Sample Card.” [yl
Installation is complete when the -
sample card prints successfully. ;_____'_—__

Network Installation Using a Print Server

Printers that do not have an Ethernet port can be used over a network by connecting the printer
to a print server that is connected to the network. Use the following instructions to set up your
print server and then complete the installation as described in "Installing the Driver Using a
Network Connection”.

1 Load supplies and then power on the printer. See "Preparing the Printer".

2 Connect the printer to the print server
using a USB cable. (Position the USB
cable at an angle to properly insert it
into the printer.)

3 Connect the print server to the network
using an Ethernet cable.

Sarver Printer USE Port

4 Set up the print server on the network.
Refer to your print server
documentation for setup information.

5 Obtain the print server IP address (or network name)
and record it. 4

Continue with step 3 in "Installing the Driver Using a Network ———
Connection" to complete the installation.
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Installing More than One Printer on a PC

There are several options for connecting more than one printer to a PC, or for connecting more
Q than one PC to a printer.

I ™ .

Install two or more printers on one PC using USB ports. See "Installing more than one
printer using a USB connection" for details.

Install more than one networked printer on a PC using the built-in Ethernet port on the
printer. Each installation follows the same procedure. See "Installing the Driver Using a
Network Connection”.

Install more than one networked printer on a PC using a print server. Each installation
follows the same procedure. See "Network Installation Using a Print Server".

Install multiple printers on a PC using a combination of connection methods. For
example, connect one or more printers to the PC using a USB connection, and connect
others through a network (using direct networking or Windows printer sharing).

Use more than one printer installed to a PC as a printer pool. The PC must be running a
Windows operating system.The operating system sends each print job to the next
available printer. See "Printer Pooling" for details.

Install a printer on a client PC when the printer is connected to a host PC and both PCs
are connected to a network (using Windows printer sharing). See "Shared Printers" for
more information.

Installing more than one printer using a USB connection

Tips for success

Connect and install one printer at a time. The PC cannot run two or more installation
programs at the same time.

Install the first printer following the steps in "Installing the Driver Using a USB
Connection". Then, install any additional USB-connected printers as described below.

The USB protocol allows devices to be connected to the PC through another USB
device (daisy-chained). USB also uses hubs to which multiple USB devices (including
other hubs) can be connected (cascaded).

— Up to five powered hubs can be used between the printer and the PC. Card printers
do not have ports to support daisy chaining. If you need to connect two card printers
to a PC with one USB port, obtain a powered USB hub to which both printers can be
connected.

— Every other hub in a daisy chain must be powered.

The printer must be powered on for the PC to detect it. It must remain powered on during
installation.

Load supplies and then power on the printer. See "Preparing the Printer" for the steps to
follow.

Log on to the PC as a user with Administrator access.
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3 Connect the USB cable to
the USB port on the PC and
the printer. Position the USB
cable at an angle to properly
insert it into the printer.

]
. f ?Insert USB cable
at an angle

4 The operating system detects the new device and begins installation. Depending on
your system’s current setup, what you see during the installation process varies.

— A pop-up window may display during installation.

If the operating system does not display a pop-up
window within a few minutes, check all cables and
connections to the printer. Then look at the Printers
window to see if the icon for the new printer displays. The software sometimes
installs without displaying the pop-up window. If the icon is not present, see
"Installation Troubleshooting" for more information.

— The operating system usually uses the existing driver files to install the driver for this
printer. Insert the driver installation CD only if you are prompted for it.

5 A message displays when the printer has been Cot e v i word R

installed successfully.

0 Thee Care Printes i susstiiafll ictabed on you PC

Using more than one printer on a PC

When you have more than one printer on a PC, keep the following in mind:

« Select the printer to use in your ID software or other application. Card jobs are sent to
the printer you select, even if more than one card printer is attached to the PC.

* When messages display, the title bar of the message box displays the name of the
printer causing the message. Keep track of which printer has which name.

e Each printer has its own icon in the Printers window, and each printer has separate
Printer Properties and Printer Preferences dialog boxes. Settings are not shared among
printers.

« The PC has a Printer Toolbox for each installed printer. Open each Printer Toolbox by
selecting Start > All Programs > Datacard Card Printers > Printer Name. When the
Printer Toolbox is open, the printer name displays in the title bar.
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Wireless Network Connection

To install the printer using a wireless network connection, you must have the following:
Q\ ¢ Equipment, including cables, for the wireless connection method you have chosen.
( | * Knowledge of wireless communication.

For wireless printing, the card printer is connected to a bidirectional wireless print server using a
USB cable. The wireless print server receives data from another wireless device. The sending
device can be one of the following:

« Part of a existing network. See "Wireless Network Connection with an Existing Network"

« Attached to a PC (peer-to-peer). See "Wireless Network Connection with a Peer (Ad
Hoc) Network"

Wireless Network Connection with an Existing Network

A networked connection

includes the typical components

of an organization's existing

network, including servers, -
cables, routers, and PCs. The

network must be enabled for

wireless communication through [
one or more access points.

Wireless Access Point

>

Wireless
Y Print Server

PCs on the network must install
the driver for the card printer to
send cards to the printer. PCs
send data over the network,
which transmits the data through an access point to the wireless print server and printer. The
printer returns status information to the PC using the same path.

PCs with Printer Drriver installed Printer

The printer location is limited by the range and availability of access points. This method also is
called infrastructure mode.

Using an existing wireless network:
e Make sure you have the following:

— A bidirectional wireless print server with cables and documentation.
— A wireless network with one or more access points available to the printer.

— A PC with a wireless adapter that uses the same wireless protocol (such as 802.119g)
as the print server.

— For a wired or wireless infrastructure (existing network) connection, the PC must be
connected to, and working on, an Ethernet network.

Note: A wireless network connection was tested using the HP Jetdirect 380x,
revision A, bidirectional wireless print server. The print server was connected to the
printer using a USB cable.
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Your network support personnel can tell you whether the network uses DHCP or static IP
addressing.

— If it uses static IP addressing, obtain the IP address, subnet mask, and gateway
address from the network support personnel. You then assign these values to the
print server.

— If the network uses DHCP, you obtain these values from the print server
configuration utility and use them when setting up the PCs that send jobs to the
printer.

Most networks use encryption to protect data transmitted using the access points. Your
network support personnel can provide the information you need to set up encryption on

the wireless print server.

To continue, see "Install and Set Up the Wireless Print Server".

Wireless Network Connection with a Peer (Ad Hoc) Network

A peer-to-peer network is
made up of PCs equipped
with wireless adapters and
the printer with a wireless
print server. The PCs have
the driver for the card printer
installed, and transmit print
data from the PC’s wireless |
adapter to the wireless print - !
server. The printer returns PCs with Printer Driver installed Printer
status information to the PC

using the same path.

Wireless adapters

A peer-to-peer network also is called a local network or an ad hoc network.

Using a peer-to-peer wireless network

* Make sure you have the following:

— A bidirectional wireless print server with cables and documentation.

— For each PC that will send jobs to the printer, a wireless adapter that uses the same

wireless protocol (such as 802.11g) as the print server.

Note: A wireless network connection was tested using the HP Jetdirect 380x,

revision A, bidirectional wireless print server. The print server was connected to the

printer by a USB cable.

« Obtain information about setting up encryption if the peer-to-peer network will use it.

To continue, see "Install and Set Up the Wireless Print Server".

Installation Guide
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Install and Set Up the Wireless Print Server

1
2
3

Log on to the PC as a user with Administrator permissions.

Installation on Windows

Prepare the printer for installation. See "Preparing the Printer” for the steps to follow.

Install the wireless network adapter,
including the adapter’s driver files, on a
nearby PC. Follow the instructions provided
with the adapter to install it.

Change settings in the utility for the
wireless network adapter (if needed) to
match the default settings for the wireless
print server. Refer to the print server
documentation for the settings to use.

Power on the wireless print server.

For best results, try to set up the print
server without connecting it to the printer.
(This sequence might be different from
the one the print server recommends). If
the wireless network adapter utility does
not find the print server, you might need to
connect the print server to the printer.

Insert the wireless print server CD in the
PC with the wireless network adapter.
Follow the instructions provided with the
print server to set it up.

Record the values you use so you can
repeat the setup for other devices or
PCs.

'\‘H-.-'_
£ pfWireless
Print Server

Prnter
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7 Do one of the following:

Existing Network:

— Set up the print server so
that it communicates with
the network through the
access point. Your
network support personnel
can provide the network
settings to use.

Metwork

| Access Point

Print Server

A

PC with Wireless Adapter

— Connect the print server
and printer using a USB =3
data cable (if it is not _
already connected). _| Access Point

You can remove the
wireless adapter from the
PC. Future communication
occurs over the network.

Metwork
I

OR
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Peer-to-Peer Network:

— On each PC that
will print, set the

wireless adapter e :
to communicate
with the print
server. P—
J

LTERT)

=I1.

— Connect the print server and
printer using a USB cable.

Install and Set Up the Driver
Install the driver for the card printer on each PC that will send jobs to the printer. Follow the
steps in "Installing the Driver Using a Network Connection" with the following changes:

Make sure that each printer has a unique name (such as Card Printer 1 or Card
Printer 2) on the PC.

Make sure that you are logged in as the Administrator. (Users without Administrator
permission cannot complete this task successfully.)

In step 1_2, enter the print server name or the IP address e oo =

of the print server. If your network uses DHCP, use the - 1

print server name and not the IP address, which the et name o P e o [ o= ]
e

network can change. Cocel |

The Print Sample Card button in the Printer Toolbox is (&/

enabled when the printer and driver are communicating.
If the Print Sample Card button is not available, check
for the following:

— The printer is suspended. Click Resume.
— The printer is busy processing a print job sent by another user on the network.

— The printer is paused. Check that the Status Light on the front of the printer is steady
green.

See "Printing Cards Using Bidirectional Communication" to print cards.
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Printing Cards Using Bidirectional Communication

In the Windows environment, the typical printer installation uses bidirectional
communication. See "Installation on Windows" for details about installing the printer. When
bidirectional communication between the printer and driver are active, the following occurs:

* The driver “reads” the type of printer connected and its options (such as duplex or
magnetic stripe), and then enables the settings (in the Printer Toolbox and Printing
Preferences) for the features available.

« The driver “reads” the type of ribbon in the printer (or, for manual-feed printers, whether
it is set for rewritable cards) and enables settings that correspond to the capabilities of
the print media.

« The driver monitors the printer, and reads any errors the printer issues. The driver
displays a message when it reads an error. You must correct the problem with the printer
to continue.

* When you select some settings, such as edge-to-edge printing, the driver sends the
settings to the printer.

e When you click some buttons, such as “Clean Printer,” the driver sends a command to
the printer and the printer implements the process.

* When you send a card to print, the following occurs:
The driver:
— Renders the data so that it can be used by the printer
— Polls the printer to determine whether it is busy or ready to print
— Sends the card data to the printer
— Reacts to information returned by the printer (such as error messages)
The printer:
— Receives the card data and prints the card
— Issues status and other information

« When the driver communicates with a network printer, it waits until the printer is
“available” before sending card data. The time between sending a card and the start of
printing is not predictable when you are printing over a network.

The Printer Toolbox and the Printing Preferences dialog box provide information about the
printer features and status. See InfoCentral > Features > Printer Toolbox to learn about the
Printer Toolbox. See InfoCentral > Advanced > Printing Preferences to learn about using
Printing Preferences. See InfoCentral > Features to learn about printer features and how to
specify settings for the features.
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Unidirectional Printing

"Unidirectional" means that the driver sends data to the printer, but does not receive any data
back from the printer—the communication is in one direction only. A unidirectional driver can be
installed on PCs running a Windows operating system. A unidirectional driver is included on the
driver CD or in the driver download files.

You must install the unidirectional driver to use the printer with Windows Terminal Services, and
in environments that require Terminal Services, such as Citrix Presentation Server.

Many features of the driver depend on bidirectional communication, including when to send
data to the printer. See "Printing Cards in the Windows Terminal Services Environment" for
information about how to operate the printer in a unidirectional environment. Consider sharing
this information with operators.

Your success might depend on the amount of data per card and number of cards sent. For best
results, use simple card layouts and send individual cards, or send batches with a small number
of cards to print at one time.

Installing the Unidirectional Driver

This section includes:
« "Before You Install"
* "Unidirectional Driver Installation for Windows XP and Windows Server 2003"
— "Network Unidirectional Installation”
— "USB Unidirectional Installation”

« "Unidirectional Driver Installation for Windows 7, Windows 8.1, Windows Server 2008,
and Windows Server 2012"

— "Network Unidirectional Installation"

— "USB Unidirectional Installation”

Before You Install
Do not rename the unidirectional printer

The printer name, (brand) UniDir, must be used for the unidirectional driver. Do not
change this part of the printer name. If you have more than one unidirectional driver
installed, you can change the (copy n) at the end of the printer name if needed. For
example, one PC could have two printers, with names Datacard UniDir and Datacard
UniDir Net, that use the unidirectional driver. The brand of your printer might be different.

Remove any existing drivers for the card printer
Before you install the unidirectional driver with Terminal Services, remove existing

drivers for the card printer. See "Removing a Printer from a Windows PC" to remove any
currently installed card printer drivers.

You can install a printer for unidirectional operation after the existing drivers are
removed.
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Unidirectional Driver Installation for Windows XP and
Windows Server 2003

These instructions apply only to PCs running Windows XP or Windows Server 2003.
Q (Note: The following procedure might differ slightly depending on the version of Windows
installed on your system.)

Network Unidirectional Installation

Windows XP and Windows Server 2003:

Use the files on the driver CD. The driver CD contains files to install the Network Ports,
which are required to install the unidirectional driver on a network.

Obtain the following information from your network support
personnel.

— You need:
< Address Mode—either DHCP or Static IP e
< |P address for Static IP address mode
< Network name if using a print server
— You also might need:
< Gateway address
< Subnet mask

— Your network personnel might ask you for the network name (if you are using a print
server), the printer’s current IP address if using DHCP, or the MAC Address of the
device.

Load supplies and then power on the printer. See "Preparing the Printer" for the steps to
follow.

Power on the print server, if used. Record the default print server name, usually provided
on the device label, or set the print server to use the IP address provided by your
network support personnel. See the print server documentation for instructions.

Obtain or set the IP address of the printer if you are not using a print server. See
"Network Address Settings" for details.

Log on to the PC as a user with Administrator permissions.

Insert the driver CD in the PC. When the Card Printer Installation window opens, click
"Exit" to close the window.
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6 Browse the driver CD to locate
the Support\Net Port Mon
Install folder.

Make sure that you locate the Sl Boame
correct file for your operating
system (32-bit). o o

7 Double-click the setup.exe file Do
in the folder to start the g 1 Fomat b
installation of a series of ports r
named CRDNETX (where x is
a number).

8 Follow the prompts to complete port [ o P i e T

installation.
Welcome to the Card Printer
Network Port Monitor Setup
Wirard

Th wall it Caed Pt Vit Part Mirster .0 i wrour
ot

M a recrrmerand Sat o dow o oS cricadona bt
]

ik Peewd i cooirue, o o i At Sewn

o

9 Open the Printers window.

10 Double-click "Add Printer" to start the installation and
click Next.

*& Printers and Faxes

File Edt VWiew Faworikes Tools Help

Address ‘% Frinters and Faxes

11 Select "Local Printer." Make sure that the option to

automatically detect and install the printer is NOT u
checked. Click "Next." =
12 In the Use the Following Port list, select "CRDNETX" Aedpnter

(where x is a number) and then click "Next."
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13

14

15

16
17
18
19
20
21
22

23

24

25

26
27

Installation on Windows

In the manufacturers and printers list
page, click "Have Disk" and browse to
the location of the driver files (such as
the driver CD).

Select the CardPrinter.inf file and follow [| e -
the prompts to continue. - Vs

Select the unidirectional driver from the (T

Printers list. The name includes UniDir (or a dd P iz
similar word). Click "Next."

L e W your pr
gl b chek Horvs Ok, I yons order e ke, corrul e prrdes dosurnerdsben or
coetgubla pirtst

[ St ot hasdesie:

He Dk

Click "Finish" to complete the driver installation.

Add Printar Wizard

Power the printer off and then back on. . gempleting the Add Pritter

Wizard

Restart Windows.

Vi have suceerilly compleiod e A8 Frrss \aiead
Vo s tha Faliwie predee saltinga

Home: Cad D

Shive riaren. <Ml Sharmdts

3 CHDNETT

Madst Cad D

Delsd Ho

Open the Printers window.
Open the Printing Preferences dialog box.
Open the Advanced page.

T chrve s vl cheh Frushe

Change the Printer Type setting to match the
model shown on the front of the printer. Click OK
on the Advanced page to save your changes.
Close the Printing Preferences window.

——
<k (" Toih )Y Coce |

Open the Advanced page of Printing Preferences again. (Changing the Printer Type
setting might change the available options.)

The default Print Ribbon Type is YMCKT. If a different type of ribbon is installed in the
printer, change the Ribbon Type.

Change other settings, such as Duplex Method or Mag Stripe Encoding Format, as
needed to match the printer. Close the Printing Preferences dialog box.

Open the Printer Properties dialog box.
Select the Ports tab.
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28

29

30

31
32

Select the port for the printer, and
then click “Configure Port.”

Enter the name or IP address of
the printer or print server in the
Enter Network Address dialog
box.

For best results if you are using a
print server and DHCP, use the
print server name (not the IP
address, which the network can
change).

Click the Test button. If the
“Successfully communicate”
message does not display, see
"Installation Troubleshooting".

Installation on Windows

Col gt | s b
e | g ke
=l

P 10 e ot [l 4 B B bt B
ket it

. s . -

"
= EC T T

G makin Sl = gy

Close the Enter Network Address dialog box.

On the General tab of the Printer Properties dialog box, click "Print Test Page" to print

the Windows test page.

33 Verify that the Windows test page prints. The image on the card

will be cropped.

34 Click OK when the card prints, and then close the Printer

Properties page.

If you have not restarted the PC and the printer, the Windows test
page might not print or might cause an error at the printer. Restart
the printer: Do not follow Windows troubleshooting.

To continue, see "Set Up the Unidirectional Printer".

o

Windows'

Congratu

N—e
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USB Unidirectional Installation
Windows XP and Windows Server 2003:

1

Load supplies and then power on the printer. See "Preparing the Printer" for the steps to
follow.

Insert the driver CD in the PC's drive. When
the Card Printer Installation window opens,
click "Exit" to close the window.

Connect the printer to the PC using

the USB data cable. Position the USB

cable at an angle to properly insert it =

into the printer. —g” '

{fiflnsert USB cable

- atanangle

The Found New Hardware wizard
opens. Click "No, not this time" and then click
"Next."

Found Hew Har

‘Welcome to the Found New
Hardware Wizard

comguer, 0. 0ron
e 'windows Update 'Web site (wih your permizsion]
Bl imn ooy iy

Can Window cornect o Windoss Updale bo search for
softwere?

Chck Miset 1o 2ontinus.

i Jif e ]

Select to install the driver from a list or from a
specific location and then click "Next."

Select "Do not search" and then click "Next."
On the Hardware Type window, select "Printers" and then click "Next."
On the Add Printer Wizard window, click

"Have Disk." Browse to the driver CD and T =TT
select the CardPrinter.inf file. o [T
Make sure that you browse to the correct rpa ;:::
location for your operating system (CD32). i T
[ T -
i of by e
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11

12

13
14

15

16

17

18

19

20

21

Follow the prompts to continue. If needed,
remove the check mark next to "Show

compatible hardware" to display more entries

in the Printers list.

Select the unidirectional driver from the list of

available drivers. The name includes
Unidirectional, UniDir, or a similar word.

Click "Next."

Click "Finish" to complete the driver
installation.

Power the printer off and then back on.

Restart Windows.

Open the Printers window:

Click the icon for the installed
unidirectional printer and select Printing
Preferences. Specify the following:

— The orientation for the card.

— Whether to print on both sides (a
duplex module is required).

Click "Advanced" to open the Advanced
page.

Change the Printer Type setting to match
the printer installed.

Click OK on the Advanced page and the
Printing Preferences page to close them.

Open the Advanced page of Printing

Found New Hardware Wizard

L, Selectihe

cormpabible prrier

maﬂaluhm
Prirkery

Card Prinkes

. manutachuees o model
(gl k. chok Harve Duk I yous predrs ok ket coroull your pedes docamenitabion ke

Installation on Windows

of your penier, | your penier came vith an ratalation

cBack [ et Cancel

Found Hew Hardware Wizard

Add Printer Wized

A

gl dk, ek Ham Disk
crmguadin (zriry

] Shams orpatile harcsn
Printers.

Have Dink.

Cepot ) piee> ] (oot ]

Add Printer Wizard

Completing the Add Printer

Wizrar

‘fouhave pustesshily completed e Add Frinie \Wizand
Tra) specihed the Indeswng predel seregT

Hame CadUnds
Share name  (Hok Shareds
Fort CRONETY
ot Card Unir
Detadt No

Testpage  No

v s wazerd], chck, Frashy

[ ron |) oo

& Casd UniDie Printisg Prefesimneis

Rtate by 506 Degress - Front: gistied
Patate by 506 Degrees - ack: Q]
Mg e Ercsdeg Format: (AT %

CT=n,

Preferences again. (Changing the Printer Type setting might change the options

available.)

The default Print Ribbon Type is YMCKT. If a different type of ribbon is installed in the

printer, change the Ribbon Type.
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22 Change other settings, such as Duplex Method or the Mag Stripe Encoding Format, as
needed to match the printer. Close the Printing Preferences window.

23 Open the Printer Properties window.

24 On the General tab of the Printer Properties window, click Print Test Page to print the
Windows test page.

25 Verify that the Windows test page prints. The image on the card
will be cropped.

26 Close the Printer Properties window. z.'?j
If you have not restarted the PC and the printer, the Windows test Windows'

page might not print or might cause an error at the printer. Restart
the printer: Do not follow Windows troubleshooting.

Congratu

To continue, see "Set Up the Unidirectional Printer".

—
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Unidirectional Driver Installation for Windows 7, Windows 8.1,
Windows Server 2008, and Windows Server 2012

These instructions apply only to PCs running Windows 7, Windows 8.1, Windows Server 2008,
or Windows Server 2012. (Note: The following procedure might differ slightly depending on the
version of Windows installed on your system.)

Network Unidirectional Installation

Windows 7, Windows 8.1, Windows Server 2008, or Windows Server 2012:

Obtain the following information from your network support
personnel.

— You need:
< Address Mode—either DHCP or Static IP it
< |P address for Static IP address mode
< Network name if using a print server
— You also might need:
< Gateway address
< Subnet mask

— Your network personnel might ask you for the network name (if you are using a print
server), the printer current IP address if using DHCP, or the MAC Address of the
device.

Load supplies and then power on the printer. See "Preparing the Printer" for the steps to
follow.

Power on the print server, if used. Record the default print server name, usually provided
on the device label, or set the print server to use the IP address from network support
personnel. See your print server documentation for instructions.

Obtain or set the IP address of the printer if you are not using a print server. See
"Network Address Settings" for details.
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4 Log on to the PC as a user with Administrator privileges.
Insert the driver CD in the PC’s drive.

If the Autoplay dialog box displays, click
Run CdBrowser.exe.

When the Card Printer Installation
window opens, click “Install the Printer.”

6 Click “Yes” on the User Account Control
dialog box if it displays.

7 Accept the license agreement and then
click “Next.”

Installation does not continue unless
you accept the license agreement.

8 On the Install page of the Card Printer
Installation, select “Directly Networked
Printer” and then click “Next.”

< lack towa: | | Concal |

9 When the completion message o e v -

displays, click OK.

o Thee Card Printer is sucesdfully installed &n your PLL

[ o ]

10 Close the Printer Properties window for the printer when it displays.
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11 Open the Printer Properties window and select the Advanced tab.

12

13

14

15
16
17
18

Add the printer driver.

Windows 7 and Windows 8.1: Select “New
Driver” to open the Add Printer Driver
Wizard.

Windows Server 2008 and Windows Server
2012: The New Driver button is unavailable
from the Printer Properties Advanced
window. To install a unidirectional driver on
the server, do the following (see the
Windows help for your operating system for
complete information):

— Make sure that the Print and Document Services server role is installed on the

server.

— Start Server Manager.

— Select Tools > Print Management > All Printers.

— Right-click the card printer and select Properties.

— Select the Advanced tab. The New Driver button is enabled.

— Select “New Driver” to open the Add Printer Driver Wizard.

Follow the Wizard prompts to add the unidirectional driver.

In the Manufacturer list, scroll to the
brand of your card printer and select it.

In the Printers list, select (brand) UniDir
and then click “Next.” Click Finish when
the installation completes.

The new driver name displays in the
Driver box of the Printer Properties
Advanced page.
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Click OK to close the Printer Properties window.

Restart Windows.
Power the printer off and then back on.

Open the Devices and Printers window.
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20
21

22

23

24

25

26

27

28

29

30

31

Installation on Windows

Right-click the printer and select Printer
Properties.”

Select the Ports tab.

Select the port for the printer, and then click
“Configure Port. Enter the name of the
network adapter (if used) or the IP address of
the printer in the Enter Network Address box.

Click the Test button. Click OK when the
“Successfully communicated” message
displays.

If the “Successfully communicated” message
does not display, see "Installation
Troubleshooting".

Close the Enter Network Address dialog box and then close the Printer Properties
window.

Right-click the printer and select Printing ——— Ty
Preferences. Specify the following: e

— The orientation for the card.

— Whether to print on both sides (a
duplex module is required).

Click "Advanced" to open the Advanced
page.

Change the Printer Type setting to

match the printer installed.

Click OK on the Advanced page and the

Printing Preferences page to close =

them.

Open the Advanced page of Printing Preferences again. (Changing the Printer Type

setting might change the available options.)

The default Print Ribbon Type is YMCKT. If a different type of ribbon is installed in the
printer, change the Ribbon Type.

Change other settings, such as Duplex Method or Mag Stripe Encoding Format, as
needed to match the printer. Close the Printing Preferences window.

Verify that you can print a card to the printer. Note: Do not print the Test Page from the
Printer Properties window to verify the installation. The test page is not supported by
these operating systems.

To continue, see "Set Up the Unidirectional Printer".
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USB Unidirectional Installation
Windows 7, Windows 8.1, Windows Server 2008, or Windows Server 2012:

1 Load supplies and then power on the printer. See "Preparing the Printer” for the steps to
follow.

Log on to the PC as a user with Administrator access.
3 Insert the driver CD in the PC's drive.

If the Autoplay dialog box displays, click Run CdBrowser.exe.

The driver installation window opens.
4 Click “Install the Printer.”

Click “Yes” on the User Account
Control dialog box if it displays. Datacard

6 Accept the license agreement and
then click “Next”.

e
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7 On the Install page of Card Printer Gk et
Installation, select “Local Printer [l
Connection” and then click “Next.” ’_@r
i My Bl i Pt
| D Frarie Prost
Y
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8 Verify that you have prepared the printer
as instructed on the Connect dialog box.

9 Connect the USB cable to the
PC and the printer. Position the
USB cable at an angle to
properly insert it into the printer.

Installation on Windows

Cureset l
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[ ] 7
l,-f Insert USB cable
at an angle

10 When the completion message
displays, click OK.

11 Open the Printer Properties window and
select the Advanced tab.

12 Add the printer driver.

0 The Card Printer is successfully ingtalled on your PC.

QK

Windows 7 and Windows 8.1: Click “New Driver” to open the Add Printer Driver Wizard.

Windows Server 2008 and Windows Server 2012: The New Driver button is unavailable
from the Printer Properties Advanced window. To install a unidirectional driver on the
server, do the following (see the Windows help for your operating system for complete

information):

— Make sure that the Print and Document Services server role is installed on the

server.
— Start Server Manager.

— Select Tools > Print Management > All Printers.

— Right-click the card printer and select Properties.

— Select the Advanced tab. The New Driver button is enabled.

— Select “New Driver” to open the Add Printer Driver Wizard.

Follow the Wizard prompts to add the unidirectional driver.
13 In the Manufacturer list, scroll to the brand of your card printer and select it.
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e e 1 Select LD and e — —~
then click “Next. = -
P gt e e Sewn e e e
i i e G s T M T
e il e i i ol ek g
15 Click Finish. The new driver name
displays in the Driver field of the o | i ey
Advanced page. st owastnbun P VL
16 Click OK to close the Printer -k :
Properties window. B et T i vk
17 Restart Windows. — = —

18 Power the printer off and then back
on.

19 Open the Devices and Printers window.

20 Right-click the printer icon and select - -
Printing Preferences. Specify the T |
following: el

— The orientation for the card.

— Whether to print on both sides (a
duplex module is required).
21 Click "Advanced" to open the Advanced
page.
22 Change the Printer Type setting to match
the printer installed.

23 Click OK on the Advanced page and the e
Printing Preferences page to close them.

24 Open the Advanced page of Printing Preferences again. (Changing the Printer Type
setting might change the available options.)

25 The default Print Ribbon Type is YMCKT. If a different type of ribbon is installed in the
printer, change the Ribbon Type.

26 Change other settings, such as Duplex Method or Mag Stripe Encoding Format, as
needed to match the printer.

27 Click OK to save your changes. Close the Printing Preferences window.

28 Verify that you can print a card to the printer. Note: Do not print the Test Page from the
Printer Properties window to verify the installation. The test page is not supported by
these operating systems.

To continue, see "Set Up the Unidirectional Printer".

Installation Guide 44



Installation on Windows

Set Up the Unidirectional Printer

Before using the printer, verify (or change) the following printer settings at the server PC. See
InfoCentral for information about settings. The settings you specify affect all clients that send
print jobs to the printer:

1

8

Set the Printer Type to match the name on the printer. Make sure to close the Properties
window to update the available options.

Set the Ribbon Type to match the ribbon installed in the printer.

Specify the Print on Both Sides setting, which controls whether the printer prints one side
or two sides of the card. Also set the Duplex method, which controls how two-sided
printing occurs. (Manual duplex is not supported.)

For printing two-sided (duplex) cards and some ribbon types, set whether to print color
on both sides.

Specify print and topcoat blocking, if needed. For manual-feed printers, set rewrite
blocking if needed.

If the printer includes a magnetic stripe option and you plan to print magnetic stripe
cards, set the Mag Stripe Encoding Format.

Specify whether to apply laminator material to one or both sides of the card (available
only on laminating printers).

Set card design features, such as portrait or landscape orientation.

The following are not available when using a unidirectional driver:

Features provided by the Printer Toolbox, including color settings, supplies information,
edge-to-edge settings, and printhead power.

Diagnostics for Card Printers.

The Firmware Update program. See "Firmware Updates” for information about updating
firmware.

See "Printing Cards in the Windows Terminal Services Environment".
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Printing Cards in the Windows Terminal Services
Environment

Features

In controlled network environments, Windows Terminal Services makes resources on the
server available to client PCs on the network. These resources can include applications,
data, and printers. The unidirectional driver can be installed in the Windows Terminal
Services environment, as described in "Installing the Unidirectional Driver".

Many driver features are not available when using the unidirectional driver. If you need one
or more of these features on a regular basis, and the printer does not have an LCD panel,
consider whether to install the bidirectional driver on another PC, and change the printer
connection from the server to the PC for short periods of time. You cannot have a
unidirectional driver and a bidirectional driver installed on the same PC.

The following features are not available using the unidirectional driver, but there are
alternative methods for the feature:

« The Printer Toolbox for the unidirectional driver does not open, which has the following
impacts:

— The Start > All Programs > Datacard Card Printers > Printer Name entry has no
effect when it is selected.

— Messages do not display on the PC when the printer has an error. If the printer has
an LCD panel, messages display on the panel and can be cleared using the keys on
the LCD panel.

If the printer does not have an LCD panel, you cannot receive information about the
cause of the error. Start by investigating the most likely causes, for example, the
printer is out of cards or ribbon, or has a card jam.

— The Retry button and the message box do not display. You must send the card job to
the printer again from the PC.

— Card counts are not available. If the printer has an LCD panel, view card counts on
the LCD panel. If the printer does not have an LCD panel, you can connect the
printer to another PC using bidirectional communication. The driver obtains the
values when you open the Printing Preferences dialog box or the Printer Toolbox.

— The Sample Card and Magnetic Stripe Sample Card functions are not available.
Connect the printer to another PC using bidirectional communication to use these
functions.

— The Clean Printer and Clean Laminator functions are not available. If the printer has
an LCD panel, use it to run the cleaning cards. If needed, connect the printer to
another PC using bidirectional communication to use these functions.

— Edge-to-edge settings are not available. Usually, you need to change this setting
only when installing a new printhead cartridge. Connect the printer to another PC
using bidirectional communication to change the edge-to-edge settings, which are
saved in the printer.
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The PC cannot automatically detect the type of printer or printer features, such as a
duplex module. Open Printing Preferences and set the printer type to match the printer.
Close Printing Preferences and open it again to make any other changes based on the
printer type.

The PC cannot automatically detect the type of print ribbon. Open Printing Preferences
and set the ribbon type to match the ribbon installed in the printer.

You cannot select the unidirectional printer in Diagnostics for Card Printers. Connect the
printer to another PC using bidirectional communication to use Diagnostics.

The Firmware Update Program is not supported. Connect the printer to another PC
using bidirectional communication to use the Firmware Update Program.

The following features are not available with a unidirectional driver and an alternative is not
available:

The Color Settings tab on the Printer Toolbox cannot be used and there is no method for
changing color settings in the driver.

Manual duplex (for simplex printers) is not available.

Printing multiple copies of the same card design, using the “Copies” setting in Printing
Preferences, is not supported.

Security features are not available.

Interactive mode, including processing smart cards and reading magnetic stripe data, is
not available.

Installation Troubleshooting

The card printer does not install when the USB cable is connected
If the printer is not recognized correctly by the PC, or if the installation was interrupted, you

/Q might need to remove a printer entry in the Device Manager before the printer can be installed.
f Y 1 Disconnect the printer from the PC.
I |
N 2 If the printer was installed, make sure it is deleted. See "Removing a Printer from a
Windows PC".
3 Open the Device Manager window. Make sure
"View devices by type" is selected in the View
menu.
4 Locate the device to delete. The device might be
called "Unknown device" or it might be located
under the Printers folder. The device might be
marked with a yellow question mark or
exclamation mark. '
M Were wnd o g pording deices
5 Right-click the device name and select Remove. s i
6 Confirm removal of the device. '_-. Gt
7 Close Device Manager. Close any other windows. " s
8 Try installing the printer again. -tonmelagngi
o W Va0 wecd gae Pl
See InfoCentral > Troubleshooting > Installation for more : e e .
information.
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A message displays when installing a second or subsequent printer on one PC
If the Printer Toolbox for an installed printer is active when an additional printer is installed, the

Q additional printer does not install correctly. Do the following:
f 1 Follow the steps in "The card printer does not install when the USB cable is connected”
54.»-’. to remove the additional printer from the PC.

2 Exit the Printer Toolbox for all installed printers.

3 Start the installation for the additional printer again.

Cards sent by a user do not print

The PC can appear to have problems when the user does not have the necessary permissions
Q to use the printer. To set permissions, see InfoCentral > Advanced > Printer Permissions.

The Printer Toolbox does not open after renaming a printer
You must restart the PC after renaming a printer. If you rename multiple printers, you must
Q restart the PC after each rename operation. If the Printer Toolbox is running when you rename
r n the printer, you are prompted to restart the PC. If the Printer Toolbox is not running when the
| printer is renamed, no prompt displays. Failing to restart the PC after each rename causes
— unpredictable results to occur.

The Card Printer does not install on a client PC

A PC can have a locally connected (USB) card printer attached, a directly networked card
Q printer attached, and be connected to a shared printer as a client PC.

i %

\ If you use more than one connection method on a PC, install the locally and/or directly
ol networked printer(s) first, and then install the shared printer last. The shared printer must have a
different name from the other printers. Shared printer names must meet the following
requirements:

« Use a name with eight or fewer characters. The printer name, including the server name
can be no longer than 30 characters.

« The printer name cannot contain spaces or special characters. Follow Windows
guidelines for allowed characters and naming restrictions.

The Print Sample Card button is not available

The Print Sample Card button in the Printer Toolbox is enabled when the printer and driver
communicate normally. If the Print Sample Card button is not available, check for the following:

e The printer is suspended. Click Resume.
« The printer is busy processing a print job sent by another user on the network.

« The printer is paused. Check that the Status Light on the front of the printer is steady
green.

For additional troubleshooting, see InfoCentral > Troubleshooting > Communication.
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Printer Pooling

Printer pooling is a Windows feature that treats a group of printers as one printer and distributes
print jobs among the available printers.

Requirements for a Printer Pool

To create a printer pool for card printers:

Install the printers to the same PC. You can use one or more of the following methods to
install the printers:

— Install the printer locally using a USB port
— Install the printer using a direct network connection
Use a supported Windows operating system on the PC.

All printers must be the same brand and have the same features to be part of the pool.
For best results, use printers with the same brand, model, and configuration. Printers
can be installed before or after the printer pool is set up and will be included in the pool.
By default, all directly connected card printers are included in the pool, so all printers
must support and use the same card features. If you need to exclude an installed card
printer from the pool, see the Solutions Guide or your service provider.

Use the method described in this section to set up printer pooling. Do not use the Enable
Printer Pooling check box on the Printer Properties dialog box for the printer. Although
Windows permits checking this box, it does not display a message if the printer does not
support it.

Printer pooling does not support interactive print processing. Do not use special features
that require interactive mode, such as reading a magnetic stripe or programming a smart
card. (During interactive processing, the PC must communicate directly with the printer
about a specific job. This information is not available to the PC when using a printer
pool.)

At least one actual printer must be installed before a printer pool can be installed.

Do not use shared printers, which cannot be part of a printer pool.
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Set up Printer Pooling

Setting up a printer pool has two
components:

.

"Install Each Printer"

"Install the Printer Pool Driver"

Install Each Printer

To install each printer:

1

Install the same type of supplies in each printer. See "Installing Supplies and Powering
On the Printer" for the steps to follow.

You must install the same ribbon type in each printer for the card data to be processed
(rendered) correctly by the driver and for each printer to accept any card sent.

Install each printer and its driver on the PC. See "Installation on Windows" for the steps
to install a local (USB) or network printer.

Define up each printer with the same settings, especially print on both sides
preferences, magnetic stripe settings, and laminate "apply material."

The print ribbon type is set based on the print ribbon actually installed in the printer and
cannot be changed.

Verify the operation of each printer individually. Do not print the Test Page from the
Printer Properties window to verify the installation. The test page is not supported by
printer pooling.

Install the Printer Pool Driver

After each printer is installed and communicating correctly, install the printer pool driver. This is
a “logical” printer to which the application sends jobs.

1

Install the printer pool driver. Start the driver installation program by doing one of the
following:

— Use the driver installation CD.

< Insert the driver CD in the PC'’s
drive.

< Click "Install the Printer” on the
Card Printer Installation window.

— Use the installation file downloaded
from the website. Double-click the file
to start the installation program.

Click “Yes” on the User Account Control
dialog box if it displays.
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3 Accept the license agreement” and
then click “Next.”

g —

R SOl SO TR s i e, |

4 Select "Driver Printer Pool" and click

“Next.”
Lol Pris Cerrstion
Disgctly Hstwer et Fins
® Do it Pl
Vs
iEah | Hed Cancel

5 When the completion message displays,
click OK.

6 Restart Windows when prompted.

7 Open the Printers window.

8 Right-click the printer icon for the pool
and select Printing Preferences.

9 Set “Print on both Sides” to “None” for
cards printed on one side, or “Flip on

vt ity
Long Edge” for two-sided cards. e

- e
Set the orientation for cards. iommengatias

1 g o Ly Lk -

10 Click Advanced to open the Advanced -
Options window. —
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11 Set the Printer Type to the same
type as the printers in the pool.

12 Click OK on the Advanced Options

m Dutacard Printer Poel fAdvarsed Document Settings

. .. Paper/Output
window and the Printing : T TR
Preferences window to close them. Coy Court: L Logy
i Document Optiong
e Podthorgt Optiond

13 Open the Advanced Options

¥ Printer Festures

14

15
16

window of Printing Preferences
again. (Changing the Printer Type
setting might change the options
available.)

In the Advanced Options window,
specify or verify the following:

— Set Print Ribbon Type to the
type of ribbon installed in all
printers.

Printer Type: SP55 Serics
Print Bibban Types YWCKT

Lk On Both Sades o Bk Typs

Duplen Method: futomats

Print Margen: [dge 1o edge

Print Elacking Pattern  Faont: Mo bletking

Print Blocking Patiern - Dack Mg blocking

Ristabe by L Degrees - Freet: Driabled

Ristate by LD Deqrest - iack: Digakled

Mg Stripe Emeoding Format (AT

May Stsipe Coserc veity: High

Print and [ncode Sequence [rcode back then pont front
My Steype Frode Orly: Doabiled

Mag Stripe [3cage Comgatibiley: Disabled

— Set Duplex Method to None for [ ok ][ Conew
cards printed on one side, or
Automatic for two-sided cards.
(Manual is not supported.)

— Specify other settings to use the same values as each printer uses.
Click OK to close the Advanced Options and Printing Preferences windows.

Select the printer pool as the printer in your card design application.

To remove a printer from the pool, see the Solutions Guide or ask your service provider.

See "Printing Cards Using a Printer Pool" for information about printing to a printer pool.

Printing Cards Using a Printer Pool

A printer pool treats a group of printers as one printer and distributes print jobs among the
available printers.

Tips for Success

To use the printer pool effectively, each card must be sent from the application as a
separate job. Some applications, such as ID software, send each card in a batch as a
separate job, while others send the batch as one job. Test the application you use to
determine the best way to send multiple cards to the printer pool.

The printer pool determines whether printers are available:

— If you do not want one or more printers to print cards as part of the pool, suspend the
printer in Print Manager. Check this each time you power on the PC.

< Inthe Printers window, right-click the printer and select “See what'’s printing.”
< On the Print Manager window, select Printer > Pause Printing

— The printer pool identifies a USB-connected printer as “available” if the printer is
powered on, even when the printer status is Suspended or Not Responding. Power
off a USB-connected printer to remove it from the pool, or suspend printing using
Print Manager.

— A network printer is not identified as “not responding” until one card is sent and not
accepted by the printer. Suspend the printer in Print Manager.
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— If the Printer Toolbox for a printer is in Advanced Setup, the printer is not available.

— If you need to use a printer separately from the printer pool, install it on another PC
or contact your service provider for assistance in removing it from the pool.

« Some applications track card completion status, and this data is available for cards sent
to the printer pool. The application can query the printer pool and obtain status for all
cards processed through the pool. Card completion status does not indicate which
printer actually printed the job.

« Make sure that the Printing Preferences are the same for all printers in the pool, as
described in "Install the Printer Pool Driver".

« For magnetic stripe encoding, use the same coercivity and magnetic stripe format values
for all printers and the printer pool. (If you select "Use printer settings,” make sure that
the settings in the printers are the same; use Diagnostics for Card Printers to view
magnetic stripe values if needed.)

Using a Printer Pool
To use a printer pool:

1 Make sure that the printers in the pool are powered on and ready.

2 Inthe application used to print cards, select the name assigned to the printer pool when
it was installed, such as Card Printer Pool.

3 Select Print in the application. The application sends the cards to the printer pool, which
randomly distributes the card jobs among the available card printers. When all printers
are busy, the printer pool keeps the card jobs in a queue until the next printer is
available. It sends the next card job as soon as any printer in the pool becomes
available.

A printer is available if:

— The number of jobs active in the printer is less than the number of jobs supported for
that printer type.

— No jobs are pending in the Windows spooler for that printer.
— The printer is not paused in Windows Print Manager.
— The printer is not set to work offline in Windows Print Manager

— The printer status displayed in Windows Print Manager is not "User Intervention
Required."

— The Printer Toolbox is not in Advanced Setup mode.

4 After a card is sent by the printer pool to a specific printer, it cannot be removed from that
printer and assigned to another printer.

When a printer issues a message, the message displays on the PC with the name of the printer
in the title bar of the message box. The printer is unavailable to print cards until the situation that
caused the message is corrected. Other printers in the pool continue to receive card jobs and
print cards.

=
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This section provides information about printing over a network using Microsoft File and Printer
Sharing. A printer is connected to a PC (host) that has the printer driver installed. After you
share the printer, users at other PCs (clients) on the network can print to it. Up to 10 client PCs
can share the printer at one time. Users at client PCs do not have the same level of access to
the printer driver as a user at the host PC.

The following operating system configurations are supported. Both the host PC and the client
PCs must have the same type of processor (either 32- or 64-bit) installed.

Host Client Refer to:
64-bit: 64-bit:
Windows 7 or Windows 7 or
Windows 8.1 Windows 8.1 "Printer Sharing for Windows 7,
: : Windows 8.1, Windows Server 2008, or
64-bit: 64-bit: Windows Server 2012"
Windows Server 2008 or Windows 7 or
Windows Server 2012 R2  Windows 8.1
32-hit: 32-hit:
Windows XP Windows XP
32-bit: 32_bit: "Printer Sharing for Windows XP or

Windows Server 2003 R2

Windows XP or
Windows 7 or
Windows 8.1

Windows Server 2003"

See "Print Cards Using a Shared Printer" to use and manage the printer.

See "Updating the Driver When Sharing Printers" if you need to update the driver when sharing

printers.
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Components

The following are the components you need to use the card printer with printer sharing.

Nebwork
Card Printer
B LSB cabl94[

Client PC Host PC

Network: A TCP/IP-compatible network must be set up and working before you begin.

Host PC: The PC with the printer attached is called the Host PC. The host PC must be
connected to the network, and have permissions for users set.

Port connection: The printer can be connected to the host PC through a USB port or a
direct network connection.

Client PC: The client PC is connected to the host PC over the network.

Setting up Printer Sharing

Requirements for Printer Sharing

A shared printer attached to a host PC over the network must meet the following requirements:

Each PC that uses the printer must have a working network connection. Verify that the
network connection is working properly.

Each PC that uses the printer must have a supported Windows operating system
installed and have service packs required by the host PC operating system. See
"Shared Printers" for a list of the supported host/client operating system configurations.

The printer at the host PC must be enabled for sharing. See the Windows help for your
operating system for complete information about enabling printer sharing.

The PC with the printer attached (host PC) must remain on at all times, with the
Windows operating system running. A user with Print, Manage Printers, and Manage
Documents permissions to the printer must be logged on at the host PC so that other
users can print, and so the printer can be installed on the client PC.

If more than one printer is connected to a PC (including a shared printer), the printers
must have different names.

Set separate access permissions for users at the host PC and for users at the client PC.
See InfoCentral > Advanced > Printer Permissions for the steps to follow.

If a client PC will have more than one shared printer installed, install one printer on the
host PC, and then install the printer on the client PC. Complete the installation of the
printer on both host and client PCs, then install the additional printers on the host and
client PCs.
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Printer Sharing for Windows XP or Windows Server 2003

The driver supports printer sharing for the 32-bit host/client configurations listed in "Shared
Printers".

Set Up the Host PC for Windows XP or Windows Server 2003

To set up the host PC for printer sharing, do the following:

i

[

1

Install the printer driver on the host PC. See "Installing the Driver with Bidirectional
Communication” for more information.

With the printer power on, change settings to reflect your card design, including printer
features such as ribbon type and magnetic stripe settings. Record the settings so you
can make the same changes on each client PC.

Change the printer name to meet the following requirements:

— The name of a shared printer is the name you assign plus the server name (which is
added by Windows). The server name is the network name of the host PC.

— For best results, use a name with eight or fewer characters. The printer name,
including the server name, can be no longer than 30 characters.

— The printer name cannot contain spaces or special characters. Follow Windows
guidelines for allowed characters and naming restrictions.

Restart Windows on the host PC.
Enable the printer for sharing:

a Open the Printers window.

b Right-click the printer icon and select Printer properties. Select the Sharing tab on
the Printer Properties window.

c Select the “Share this printer” check box. The first eight characters of the printer
name, assigned by the operating system, display in the Share name field. Leave the
name as it displays.

Clear the “Render print jobs on client computer” check box.

Click Apply to save your changes, and then click OK to close the Printer Properties
window. The icon for the shared printer now displays a shared symbol.

Set up an account for each user at the host PC.

Set up accounts for users who log onto the host PC and for users who log onto the client
PC(s).

Grant users permission to the printer from the host PC, including:

— Client PC users who have Print permission to the printer.

— Host PC users who also have Print, Manage Printers, and Manage Documents
permissions to the printer.

— Host PC users (if any) who are denied permission to the printer.

See InfoCentral > Advanced > Permissions for more information.
Make sure that client PC users can access the host PC from the network.
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Set up the Client PC

r

Q

1

2

Shared Printers

Set up an account for each user of the client PC.

At least one user must have administrator access to both the client and host PCs to
install the driver.

Make sure that client PC users can access the host PC from the network.

Install the Printer Driver on the Client PC

A client PC may use any of the supported Windows operating systems. Refer to "Shared
Printers" for a list of supported host/client operating system configurations. Except as noted, the
following steps apply to all client Windows systems. The window names may vary slightly based
on the operating system of the client PC.

[

i

Use the following process at the client PC to install the printer. If more than one client PC will
share the printer, repeat the procedure at each client PC. Restart Windows before printing from
the client PC.

1

Make sure that the printer and driver on the host PC are working properly before
beginning.

Log on to the client PC as an Administrator, and log onto the network.

Locate the host PC on the network and log into it using the user name and password
defined on the host PC. Keep the window open during printer driver installation.

On the client PC, do the following:

— Windows XP: Click Start > Settings > Printers and Faxes to open the Printers and
Faxes window.

— Windows 7 or Windows 8.1: Click Start > Devices and Printers to open the Devices
and Printers window.

Select Add Printer to start the Add Printer wizard.

In the Add Printer window, do the following:

— Windows XP: Select “A network printer, or a printer attached to another computer."”
— Windows 7 or 8.1: Select “Add a network, wireless, or Bluetooth printer.”

Follow the prompts in the Add Printer wizard to select the printer.

— Select to browse for the printer. An expandable list of network servers, PCs, and/or
printers appears. If needed, double-click a server or PC name to see the names of
attached printers.

— Select the printer to which the user will print. The printer name displays in the Printer
box.

— The printer name includes the name of the host PC. Make sure the name of this
printer is different from the names of any other printers attached to this PC.

— Click No if you are prompted to print a test page. You must set values in the client PC
Printing Preferences window before printing.

— Do not restart the computer if prompted.

Click Finish to close the wizard when it completes. The shared card printer icon displays
in the Printers and Faxes window of the client PC.

Right-click the printer icon and select Printing Preferences.
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9 Change the printing preferences settings on the client PC to match those on the host PC
and your card design. Some settings are set from the host PC and cannot be changed at
the client.

— The client PC obtains the Printer Type and Ribbon Type from the host PC. If it cannot
obtain the values from the host PC, the client PC uses the default values or the last
set of values obtained from the host PC.

— Change settings that apply to the printer, such as magnetic stripe settings, so they
are the same as those on host PC.

— Change settings to reflect your card design, such as portrait or landscape
orientation. These settings can be different from the settings on the host PC.

10 Close the Printing Preferences window.
11 Open the Printer Properties window and click "Print Test Page" on the General tab.

12 Verify that the Windows test page prints and close the Printer

Properties window. /—
13 Restart the client PC. o f'? y
14 Assign Print permission to the printer for each client PC user who Windows’
uses the printer.
See "Print Cards Using a Shared Printer" to use and manage the printer. Cangraty
Tips for Success N———

A PC can have a locally connected (USB) card printer attached, a directly networked
card printer attached, and be connected to a shared printer as a client PC.

If you use more than one connection method on a PC, install the locally and/or directly
networked printer(s) first, and then follow the steps in this section to install the shared
printer last. The shared printer must have a different name from the other printers.

« See Windows help for information about printer naming, including shared printers.
« If you update the printer driver on the host PC, the driver on the client PC may update

automatically or may require a manual update. See "Updating the Driver When Sharing
Printers".

« If you need to remove the driver from the client PC, see "Removing a Printer from a
Windows PC" for more information.
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Printer Sharing for Windows 7, Windows 8.1,
Windows Server 2008, or Windows Server 2012

The driver supports printer sharing for the 64-bit host/client configurations listed in "Shared
Printers".

Set Up the Host PC for Printer Sharing

~N o o b~

10

11

12

Install the printer on the host PC.

With the printer power on, change settings to reflect your card design, including printer
features such as ribbon type and magnetic stripe settings. Record the settings so you
can make the same changes on the client PC.

Change the printer name to meet the following requirements:

— The name of a shared printer is the name you assign plus the server name (which is
added by Windows). The server name is the network name of the host PC.

— For best results, use a name with eight or fewer characters. The printer name,
including the server name, can be no longer than 30 characters.

— The printer name cannot contain spaces or special characters. Follow Windows
guidelines for allowed characters and naming restrictions.

Restart the host PC.
Open the Devices and Printers window.
Right-click the printer icon and select Printer properties. Click the Sharing tab.

Select the “Share this printer” check box. The first eight characters of the printer name,
assigned by the operating system, display in the Share name box. Leave the name as it
displays.

Clear the “Render print jobs on client computer” check box.

Click Apply to save your changes, and then click OK to close the Printer Properties
window. The icon for the shared printer now displays a shared symbol.

Set up an account for each user of the host PC.

Set up accounts for users who log onto the host PC and for users who log onto the client
PC(s).

Grant users’ permission to the printer from the host PC.

See InfoCentral > Advanced > Permissions for more information.
Continue with "Install the Driver on the Client PC".

Install the Driver on the Client PC

A client PC may use any of the supported Windows operating systems. Refer to "Shared
Printers" for a list of supported host/client operating system configurations. The window names
may vary slightly based on the operating system of the client PC.

[

i

Use the following process at the client PC to install the printer. If more than one client PC will
share the printer, repeat the procedure at each client PC.

1
2

Log on to the client PC as an administrator, and log on to the network.

Locate the host PC on the network and log into it using a user name and password
defined on the host PC. Keep the window open during printer driver installation.

On the client system, open the Devices and Printers window.
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4 Select Add a Printer to start the Add Printer wizard.
In the Add Printer window, select “Add a network, wireless, or Bluetooth printer.”
6 Follow the prompts in the Add Printer wizard to select the printer.

— Select to browse for the printer. An expandable list of network servers, PCs, and/or
printers appears. If needed, double-click a server or PC name to see the names of
attached printers.

— Select the printer to which the user will print. The printer name displays in the Printer
box.

— The printer name includes the name of the host PC. Make sure the name of this
printer is different from the names of any other printers attached to this PC.

— Click No if you are prompted to print a test page. You must set values in the client PC
Printing Preferences window before printing.

— Do not restart the computer if prompted.

Click Finish to close the wizard when it completes. The shared card printer icon displays
in the Devices and Printers window of the client PC.

7 Right-click the icon for the shared printer and select Printing Preferences.

8 Change the printing preferences settings to match the settings of the host PC. Some
settings are set at the host PC and cannot be changed from the client PC.

— The client PC obtains the Printer Type and Ribbon Type from the host PC. If it cannot
obtain the values from the host PC, the client PC uses the default values or the last
set of values obtained from the host PC.

— Change settings that apply to the printer, such as magnetic stripe, so they are the
same as those on the host PC.

— Change settings to reflect your card design, such as portrait or landscape
orientation. These settings can be different from the settings on the host PC.

9 Close the Printing Preferences window.

10 Open the Printer Properties window and click the Print Test Page button on the General
tab.

11 Verify that the test page prints and close the Printer Properties window.
12 Restart the client PC.

13 Assign Print permission to the printer for each client PC user who uses the printer. See
InfoCentral > Advanced > Printer Permissions for more information.

Tips for Success

« To install the printer for additional clients, repeat the procedure. A user with Print
permission to the printer can install the driver after it has been installed by an
Administrator.

¢« A PC can have a locally connected (USB) card printer attached, a directly networked
card printer attached, and be connected to a shared printer as a client PC.

If you use more than one connection method on a PC, install the locally and/or directly-
networked printer(s) first, and then follow the steps in this section to install the shared
printer last. The shared printer must have a different name from the other printers.
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¢ If an error message displays when connecting to the
printer, similar to the one shown, restart Windows x
and repeat the procedure. [|

Connect i Pristes —g

* The Start menu at the client PC contains entries for the printer. The user who installed
the printer can use them to open the Printer Toolbox and InfoCentral.

Print Cards Using a Shared Printer

Microsoft File and Printer Sharing enables a user at one PC to print to a printer attached to
another PC.

Metwork

I I l 1 Card Printer

- -
I — USBE cable

|
'

Client PC Host PC

A printer is connected to a PC (host) and has the printer driver installed. After you share the
printer, users at other PCs (clients) on the network can print to it. Up to 10 client PCs can share
the printer at one time. The driver is installed on the host PC and then on each client PC.

Use the Printer from the Client PC

Users at the client PC can perform several actions, including:

« Print a card. To send cards to print from an application on the client PC, select the
printer in the application and then select Print.

« Print a card using an application and magnetic stripe fonts. When printing from an
application such as Microsoft Word, use the magnetic stripe fonts provided by the printer
driver to format text for magnetic stripe encoding. See InfoCentral > Advanced >
Magnetic Stripe > Fonts for more information.

« Change some card design settings. You can change the card orientation (landscape
or portrait) from the client PC. Many settings are read from the host PC and cannot be
changed at the client PC. Those settings are disabled at the client PC.

¢ View the status of the client PC. The Printer Toolbox is available on the client PC. It
displays the client status and a reminder that messages and additional status
information is available on the host PC.

e Usethe Color Settings tab of the Printer Toolbox. The color settings can be used to
fine-tune the appearance of cards sent from a client PC running a 32-bit Windows
operating system. See InfoCentral > Printer Features > Printer Toolbox > Color Settings
Tab.
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Pause or delete print jobs from Print Manager. A paused card job remains in the print
gueue until it is sent to the printer (or deleted). See Windows help for information on
using Print Manager.

View Print Manager. Expand the Status column in Print Manager to see messages from
the host PC.

Management Tasks at the Host PC

The user at the host PC has more control over the printer and can see more information
about the printer. You can perform the following additional tasks at the host PC.

Print a card. To send cards to print from an application on the host PC, select the printer
in the application and then select Print.

Manage all jobs in the print queue. Use Print Manager to view all jobs in the print
gueue and to pause or delete any jobs in the queue, no matter who submitted the job. A
paused job remains in the print queue until it has been sent to the printer (or deleted).
See Windows help for information on using Print Manager.

See and respond to messages. If the printer is not able to process and print a card, the
driver displays a message on the host PC. The message does not display on the client
PC. The host PC can see the message and view help, which provides information to
resolve the situation. The title bar of the message contains the printer name. Printing for
all users is suspended until the situation is resolved.

Set values in Printing Preferences. Values set at the host PC apply to all users (unless
changed at the client PC). Some values can be changed at client PCs, but those values
apply only to the print jobs sent from the client PC.

View printer status. The host PC runs the Printer Toolbox and all status functions. The
Printer Toolbox is closed by default. To open the Printer Toolbox, select the printer from
the Windows Start menu.

Use all features of the Printer Toolbox. The Printer Toolbox on the host PC provides
access to all printer settings, including edge-to-edge settings and color controls.
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Updating the Driver When Sharing Printers

When you use printer sharing, the host PC and all client PCs must be at the same version of the
driver to work properly. Depending on the operating system installed on the host and client PCs,
\ one of the following can occur:

|: | .
- 4

The driver on the client PC is updated automatically after you update the host system
and restart it. See "Driver Updates" for information about updating the driver.

The driver on the client PC must be updated manually. If the driver on the client PC
requires a manual update, the text “Needs new driver” displays when you select the
printer on the Devices and Printers window on the client PC. (Windows XP users: Open
Windows Print Manager and look at the Status column to see messages.)

Update a Client PC Manually

To update the driver on a client PC that requires a manual update, do the following:

1

Record settings at the host PC and at the client PC in case you need to enter them
following the update.

Open the Printers window on the client PC.

Select the printer. The text “Needs new driver” displays next to the printer name and
Update Driver displays on the menu bar.

Select Update Driver.

On the Do you trust this printer dialog box, click “Install Driver.” The updated driver is
installed on the client PC from the host PC.

Press F5 to refresh the Printers window to clear the “Needs new driver” message.

Verify the Client Update

Atfter the client PC has been updated with the new driver version, verify that the update
completed properly and that your settings and preferences were not changed.

1
2
3

Open the Printer Toolbox on the client PC. B i e —r
View the version of the driver. ‘

Review your printer properties settings and printing
preferences and verify that they are correct. Update e e
them, if necessary. | Brssrsns

hoearoea RS Femrg i

Print sample cards to confirm that cards print
successfully. e
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Installation on Non-Windows Platforms

This section provides information about installing the printer an OpenCard-enabled system.

OpenCard Installation

. The OpenCard option is available for 32-bit operating systems only. Printers with the Built-in

= Ethernet and OpenCard option include an LCD panel, which provides access to status
information and configuration settings. Printers with the OpenCard option can print cards
using the OpenCard data format (when the data format is set to OpenCard). The option
includes a CD that contains utilities, samples, and the Data Formatting Guide (in PDF
format).

Plan for the following installation and setup steps:

1 Define the requirements for the card to guide you in the installation and setup. See the
Data Formatting Guide for details about supported card features.

2 If you need to change settings, such as K power, install the printer and driver on a
Windows PC. You also might want to install Diagnostics for Card Printers if you need to
set up a custom magnetic stripe format. The data format must be “Printer Driver” to use
the driver and Diagnostics for setup. See "Installation on Windows" for the steps to
install the Card Printer Driver for Windows.

3 Use Telnet to connect the printer to a PC to define card layouts in the printer. See Data
Formatting Guide > Getting Started > Connecting the Printer. The data format must be
“OpencCard” to use the Telnet menus in the printer. Print sample cards to verify that cards
meet your requirements.

4 Connect the printer to the production system and configure the system to communicate
with the printer. The data format must be “OpenCard” to receive data from the host and
use it to print cards.
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Set the Data Format

Before you send any data to the printer, set the data format so the printer can receive the
data you send.

1 Press the Enter key to enter the menu system.

2 Press the Up or Down Arrow key to scroll to “Configuration” and press the Enter key.

Main Menu - Line 1
Configuration —= Line 2

AL i
OO

Down Entar Status
AITow Light

Up Ready
Arrow

3 Press the Up or Down Arrow key to scroll to “Data Format” and press the Enter key.

Configuration
> Data Format

4 Press the Up or Down Arrow key to display the data format you want to use on the
second line of the display. Press the Enter key.

Data Format
= Open Card

5 The “Apply/Restart” prompt appears on the second line of the display. Press the Enter
key to confirm the data format selection and restart the printer.

Data Format
> Apply/Restart

After restarting, the printer is ready to accept data in the format you have selected.

(@
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Updates, Upgrades, and More

This section describes:
e "Updates"
e "Upgrades"
e "Deviations"

* "Removing a Printer from a Windows PC"

Updates

An update replaces part of the product you have—usually software—with a newer release.
Driver updates and firmware updates are the most common types of updates.

Driver Updates

Driver updates are available from the website or from your service provider. See InfoCentral >
Contact Us for contact information.

Read the information about supported printers and operating systems before installing a driver
update to make sure that your printer and operating system are supported by the new driver.
See "PC Requirements" for a list of operating systems supported by the driver.

You usually can update to the latest driver version without having to remove all installed printers
and reinstall the new driver. The updated driver retains your printing preferences and selections
from the previous version.

If your current driver cannot be updated, remove the printer and driver from your system and
install the new driver.

If you currently have an installed printer and you want to install a new printer that uses a newer
version of the driver, you must update the installed driver before you can install the new printer.

You can update the driver using a new driver CD or using files downloaded from the website.
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Updating the Driver Using Downloaded Files

1

9

Prepare the printer for installation. See "Preparing the Printer" for the steps to follow.
Log on to the PC as an Administrator.

Locate the downloaded file. See "Obtaining the Downloaded File" if you need to
download the driver.

Double-click the downloaded file on the PC.
Click “Continue” on the User Account Control dialog box if it displays.

The License Agreement window displays. Accept the license agreement and then click
“Next.”

When the Update Confirmation dialog box

displays, click “Yes” to continue. pdae conemation [

Durves wersicn LRDIS10 is curently installed,
Do you want to update to version 14025807

M you choose no, setup will get.

Ves [

When the update completes, 0Ne OrtWO . o, vossi Vel SN, =

“Update successful” dialog boxes |
display. Click “OK.”. B

T'OU PRI PRV TR COMIpLAN 1T TSRS L reter mtslsicn

Restart the PC to complete the update.
o Datacard Frirer B

Ji, ou munt restart your computer belore you can U the prise

Updating the Driver Using the Driver CD

a b~ W N P

Log on to the PC as an Administrator.

Insert the driver CD in the PC’s drive. The Card Printer Driver Installation window opens.
Click “Install the Printer.”

Click “Continue” on the User Account Control dialog box if it displays.

The License Agreement window displays. Accept the license agreement and then click
“Next.”

When the Update Confirmation dialog T ik P e i e—

Datacard

box displays, click “Yes” to continue.
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7 When the update completes, the 1 i e bk H
“Update successful” dialog boxes
display. Click “OK” to finish.

8 Remove the CD from the PC.
9 Restartthe PC to complete the update.

Firmware Updates

Firmware updates sometimes are available from the website. Firmware usually is updated using
a program and a separate firmware update file. The program guides you through the update
process. In most cases, you should update firmware when your service provider recommends it.

Make sure that you select the firmware update file that exactly matches your printer type.

Upgrades

An upgrade adds functionality to your printer. Upgrades typically are physical changes to the
printer, performed by your service provider. Depending on the printer, the following types of
upgrades might be available:

— Magnetic stripe module

— Smart card module

— High-capacity input hopper
— High-capacity output hopper

Field upgrades come with installation instructions designed for trained service providers.
Instructions for using the new functionality are included in InfoCentral > Features.
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Deviations

Deviations are specially adapted products, created as a special-order. Most often, the driver or
the firmware is deviated; sometimes the hardware (printer) also is changed. If you have a
deviated driver, firmware, or printer, be very careful about updating the driver or firmware. A
deviated driver or firmware has a version number with “d” near the end, similar to the following:

Firmware Version: 12.11.d1
Driver Version: 13.0.123-d2

Always check with your service provider to determine whether to install the update. Do not
update until you are sure that the update supports the special features of your product.

Deviations might be called by a different name in your organization. Other names might include
RPQ, custom, or special. RPQ stands for Request for Price Quotation, which is one of the first
steps in developing an agreement to create the deviated product.

Removing a Printer from a Windows PC

To remove the printer and all driver files from the PC, do the following. (Note: The following
screens might differ slightly depending on the version of Windows installed on your system.)

1 Logon tothe PC as a user with Administrator privileges.
2 Open the Printers window.

3 Select the printer and open the

. . N e T [
Print Manager window to check E;-“fd”D“Emt -
for any print jobs in the queue. DocumentName | Statws | Owner Pages  Sie Submitted Part
H Tall 1 1 Sam le Test Card Paused user 2 667 KB 10:55:34 AM 1/25/2008
AIlOW JIObS to Enlshh prlntlng or fSErr_\_;\f'[aé Card Paused user 2 667 KB 10:57:14 AM 1/25/2008
cancel any jobs that you want
to delete.

2 document(s) in queue

Make sure that there are no
print jobs in the print queue.
You cannot delete a printer that
has jobs in the print queue.

4 Power off the printer.

Disconnect the USB or network data cable from the printer.
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6 Open the Printers window.
Right-click the printer icon
and select “Remove
Device.”

7 Click “Yes” to confirm that
you want to remove the
printer.

8 Repeat steps 2 through 7
for each card printer you
want to remove.

9 From the Start menu,
select All Programs >
Datacard Card Printers >
Uninstall Driver Software.

Windows 8.1, Windows
Server 2008, and Windows
Server 2012 Users: From
the Windows Start screen,
display the Apps screen
and select Datacard Card
Printers > Uninstall Driver
Software.

10 Click “Yes” when asked if
you want to delete all driver
files.

A message displays when the driver files are deleted.

Updates, Upgrades, and More
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11 Close all applications and then click “OK” to restart the computer and complete the

removal.
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